
Automatic Operation of PeerSync
See Also Build Batch Lists, Reporting, File Options

To run PeerSync automatically, you must first create a batch list of folders to synchronize.    Note that the 
order in which they appear is important and spaces are used to separate the options.

1. Select the PeerSync icon as follows:

Win 3.X: Select the PeerSync icon in the Program Manager and hit Alt-Enter to display the
file information dialog box.

Win 95:    Select the PeerSync icon from the PeerSync folder and create a shortcut to 
PeerSync.    Select the shortcut icon and hit Alt-Enter or using the right mouse 
button, select “Properties” from the pull down menu.    Go to the “Shortcut” tab.

2. At the end of the application command line enter the name of the Batch List file that you want to run.
Note: Quotes are required if there are any blank spaces used in the file/path names.

Example: "C:\PEERSYNC\PSync32.EXE" "NETBAT1.SNC"
3. Leave a space and enter “AUTORUN” (or -A) if you want the synchronization to commence 

automatically.    Without AUTORUN, PeerSync will start with the batch file loaded as the default 
settings.

Example: "C:\PEERSYNC\PSync32.EXE" "NETBAT1.SNC" AUTORUN
4. To run PeerSync minimized during AUTORUN operations, leave a space after AUTORUN and type 

“MIN” (or -M).    MIN can only be used with AUTORUN.
Example: "C:\PEERSYNC\PSync32.EXE" "NETBAT1.SNC" AUTORUN MIN

5. To post a batch file delay warning dialog box prior to automatic operation, add "D" plus the number of 
seconds you want the delay to run.    For example "D10" would delay the start by 10 seconds giving 
you an opportunity to cancel the process. This delay can only be used with AUTORUN (with or 
without MIN).

Example: "C:\PEERSYNC\PSync32.EXE" "NETBAT1.SNC" AUTORUN MIN D5
6. Change the name of the icon to reflect the automatic operation name.

7. Repeat this operation for each automatic operation required.

Additionally, command line arguments can include default folders for PeerSync to start in when launched. 
If one folder is listed then both source and target default to that folder.    

Example: "C:\PEERSYNC\PSync32.EXE" "C:\DOCS"
If two folders are listed, separated by a space, then the first folder is the default source folder and the 
second is the default target folder.

Example: "C:\DOCS" "G:\DOCS"
Any icons that get created can be automatically lunched from within a scheduling program at specified 
intervals.



Build Batch Lists
See Also Run Batch Lists

This screen allows you to build batch lists containing multiple source and target folder combinations.    
This list can contain 10 or more individual combinations of folders and each item in the list can have its 
own unique set of file options as set in the File Options screen and Compression screen

Build Batch Features
Bidirectional synchronization: Build a batch list with the source and target folders entered twice, 
with the second item in the list showing the folders reversed.    (You can use the “Swap Source and 
Target” function in the Options menu.)

Changing the batch list order:    Using the mouse, select the line item to be moved, then click and 
drag that item to its new position in the list.    The items in the list will automatically be re-indexed.

Activating an Item:    Clicking on an item in the list will change the selected folders in the source and 
target folder and drive listing.

New: Clears the current list (if any).

Open:    Displays a file open dialog box allowing you to select an “SNC” batch file.

Save:  Displays a file save dialog box allowing you to save the current batch.

Add:    Adds an item to the bottom of the current list of items.    All settings in the File Options screen 
will be stored with the added item.

Delete:    To delete an item from the list, first select the item by clicking the mouse on it then select the
delete button.

Update:  To update an item in the list, click on the item to be updated, then make the appropriate 
changes to the drive, folder and file options, then select the Update button to capture all changes for 
the selected item.

Description:    This text field allows you to store a more detailed description of the active batch file.

Manually Editing Batch Items
To manually edit an item in the batch list, click the mouse on the line item to be edited and then click 
the right (or off) mouse button.    You can then use the keyboard to modify the selected item.



For Win95/NT only: Network paths (UNC) can be explicitly entered in the source and target fields of 
the batch build screen.    Example path name: “\\BackOffice\c\apps”.    If the path is valid, 
PeerSync will synchronize files during Batch Processing.



Compression
The Compression Options screen provides a means for setting file/folder compression options.

Overview
The compression utility creates a single file for every folder that is in the    target folder set.    Directory 
structures will be created to match the source directory structure.    This is done to minimize the 
amount of data that will be added to each compressed file.    If only one    file were used for the entire 
directory structure and that one file became corrupt, all files may be lost.    With the scenario of one 
file per folder if a file were to become damaged, only the data in that one folder may be unusable 
instead of the entire directory structure.    

All selected source files are first compressed then added to the target folder compressed file.    The 
compression option respects all features of the File Options screen including Replication and Delete 
Unmatched.    

The compressed folder files can be uncompressed using most popular extraction utility programs 
(assuming you have the password, if any).

File listings that are compressed will be displayed in red in the Folder Selection screen and in the 
Display Reports option lists.

Use Compression
Enables/disables the compression feature.    This option is duplicated in the Synchronize screen

Compress/Expand
Set the compress verses expand option.    If a compressed folder file does not exist during compress 
operations, one is created automatically.

Compression Speed
Sets the internal method for compressing files.    

Normal: balances speed with file size.    For most users this option should provide the best overall 
results.

Maximum Compression: gives up processing speed for to create the smallest possible file size.    In 
this mode, all ZIP, LZH, ARC and ARJ compressed files will be copied to the compressed file with no 
additional compression.    For example if you want to compress 10 files in a folder and two of these 
files are ZIP files, these two ZIP files will not be further compressed in the compressed folder file.    
Additional compression of these files would be very slow and will result in minimal, if any, additional 
compression.

Maximum Speed: gives up some file size for improved speed.

Password - Encryption



The password that is entered here will be used as a key for encrypting the compressed files.    Without
this key the original file cannot be extracted form the compressed files.    DO NOT LOSE this 
password, without it you will not have access to your files and TDM Inc. cannot recover the encrypted 
files.

Change Password:    Selecting this button will display a dialog box that will allow you to change the 
existing password.    If a password was previously entered, you must first enter the old password 
before you can change it.

Save Password:    This feature will encrypt the entered password into a file in the PeerSync folder 
and load the password for each subsequent PeerSync execution.    This is a convenience feature so 
you do not have to reenter the password each time you want to compress or extract files.

Note:    The password is automatically saved in each Batch Item Listing so you will not need to enter 
the password during batch operations.

Compressed Folder File Extension
The text in this field will be used to create the folder compressed file extension name.    For example, 
if the extension is "PS1" and the folder name is "Samples" then the compressed folder file name will 
be "Samples.PS1".    (Default is "ZIP"). 

(For Win3.x only) This file extension must be no more than 3 three (3) characters long.



PeerSync Help Contents
Thank you for using PeerSync.    This product can save you many hours of file matching time if 
used carefully.    Please practice using this product on non-essential data until you are 
comfortable using the many features.
The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. 
User assumes all responsibility for any data loss or damage.

The following Help Topics are available:    (For Help on Help, Press F1)

Registering and Password Information
PeerSync History and Description
What’s New in Version 3.x
Automatic Operation
Replication Features
PeerSync Menus
      

Main Tab Set

Folder Selection
Synchronize
Build Batch Lists

Option Tab Set

File Options
Compression
Reporting
Run Batch Lists



File Options

The File Options screen provides a means for selecting files for synchronization.    

File Options Features
File Attributes:  Select the attributes of the files you would like to include.

File Dates:    Set the dates of the files you would like to include.    You can set the system to 
automatically select any file changed in the past X number of days by selecting the “Today and Past X
Days” option.    This setting will always use the current PC system date and X number of days prior.    
A value of zero (0) represents files that have changed today only.

File Filters:    Setting the file filters will reduce the set of files that are considered for synchronization.  
Multiple filters can be set by separating them with a semi-colon, “;”.    For example:    

*.* is the default setting 

*.doc MS Word documents only 

*.doc;*.wks MS Word documents and Excel worksheets.

Note: These filters are not case sensitive, i.e.: “*.doc” = “*.DOC”.

Each filter that is set can be saved in the pull down list by selecting the “Enter” key after the filters are 
set.    This list of filters will be retained in the application initialization file and the filters will then be 
available for future use.    The last filter setting that is set when the application is terminated, will be 
the filter set used on subsequent running of the application.    The list will retain a maximum of 10 filter
settings.    To delete a setting, select the desired setting and hit the “delete” key.    See PeerSync 
Menus for more information regarding saving and retrieving initialization settings.

File Exclusion:    Files can be selectively excluded by several methods.    The first method is to 
identify characters or sets of characters, strings,    to search for within the file name.    If a file name 
contains this string, the file is eliminated from the file listing.    Multiple strings can be designated by 
separating them with a semi-colon, “;”.      For example eliminate::    

tmp - if any file contains “tmp”

.tmp - if any file that has the extension “tmp”

“.bak;.tmp” - if any file that has the extension “tmp” or “bak”

or an extreme example

“s;f;g” - if any file contains either an “s”, “f” or “g”

Note: These strings are not case sensitive, i.e.: “a” = “A”

The next method of file exclusion is to set the maximum file size (in bytes).    For example to exclude 
files larger than 500K, enter >500000.    Zero (0), the default, includes all files.

The third and last method to eliminate files is to set the minimum file size (in bytes).    For example to 



exclude files smaller than 10K, enter <10000.    To exclude files of size zero (0), enter <1.    Zero (0), 
the default, includes all files.

Misc. File Options
Include Sub-Folders:  Sets an internal flag to recursively synchronize the current folder and all sub-
folders.    This option is duplicated in the Synchronize screen.

Create Sub-Folders:      If the option is selected, PeerSync will automatically create or change to a 
matching folder in the target folder if one does not exist with the current source folder name.    If this 
option is not on, the contents of the current source folder will be synchronized to the current target 
folder.    If Include Sub-Folders is selected, all subsequent sub folders will be changed to or created on
the target folder.    

Add Files:    Sets an internal flag to add files that do not currently exist in the current target folder.      
This option is duplicated in the Synchronize screen.

Update Files:    Sets an internal flag to update older files that exist in the current target folder.    This 
option is duplicated in the Synchronize screen.

Delete Unmatched:  If this option is selected, any UnMatched files in the Target folder will be deleted
automatically.    Unlike the Replication feature, using this option will only check files that meet the File 
Options selection criteria.    A timer dialog box will be presented when this option is toggled on to allow
the user to enter a delay in seconds that will appear prior to file deletion.    When this option is toggled 
on the Display Reports options Use Report Form and List Unmatched Files will automatically be set to
the checked position.    

Caution: Use this feature carefully.    There is no way to recover deleted files once they are deleted.

Replicate Folders:  If this option is selected, all File Options settings will be ignored and PeerSync 
will Synchronize all files from the Source folder to the Target folder.    delete Unmatched is required.



Folder Selection
See Also File Options

The Folder Selection screen displays the Source and Target folders.    Use this screen to change to the 
folders requiring synchronization.    Displayed files represent the files that fit the File Options screen 
criteria.    If any files are set to be excluded from the File Options screen, they are not displayed in this list.

Folder Selection Features
Sorting: File listings can be displayed in the native order or sorted alphabetically by choosing the 
“Sort File Lists” item under the Options menu

Swapping Folders: The Source and Target folders can be swapped by selecting the “Swap Source 
and Target” menu item under the Options menu.

Drag and Drop Files:    Files can be selected from the source file listing and dragged to the target file
list only. Target to source drag and drop operations are not supported.    This allows for selective file 
synchronization. 

Operating on compressed files:
If source file list is red and files are dragged and dropped onto black target listing, selected files will 
be expanded to the target folder.    

If source file list is black and files are dragged and dropped onto red target listing, selected files will 
be compressed to the target folder.

If Use Compression is checked, source file list is black and target View Compressed toggle is 
disabled, dragged files will be compressed to target.    If View Compressed is enabled, files will not be 
compressed.

If Use Compression is checked, source file list is red and target View Compressed toggle is disabled, 
dragged files will be expanded to target.    If View Compressed is enabled, files will not be expanded.

Drag and Drop Folders    Folders can be selected from the source folder listing and dragged to the 
target file listing.    This allows for selective folder synchronization.    If Include Sub Folders is selected,
all sub folders in selected source folder will be included.

Deleting Files:    Files can be deleted from the source or target file listings by highlighting the file(s) 
and then selecting the Delete key.    This option also works with compressed files (red).

Pop Up Menus:    Chose the Enable Pop Up Menus item under the Options menu to enable the pop 



up menus for the file and folder pop up menus.    To activate the pop up menus, move the cursor over 
either the folder or file listing and select the “off” mouse button (normally the right button).

View Compressed:    This toggle will be available if a compressed folder file is available (See 
Compression options).    When a compressed folder file is detected and this toggle is checked, the 
files that are contained within the compressed file will be displayed and the file list color will change to
red.



PeerSync History and Description
Welcome to the TDM Corporations Folder Synchronization Utility Software, PeerSync.    With this utility 
you will be able to conveniently synchronize folders for backup purposes or portability requirements.    
Never again will you overwrite newer files by manually attempting to update a file or the entire contents of 
a folder. 

History
PeerSync has been available as a shareware product on the CompuServe network since early 1995.    
Since then over 500 downloads have been logged from the various international forums where the 
product was available.    PeerSync is a MS Windows based product.    Originally written in Visual Basic, 
the current product is written in Delphi Object Pascal.    After reviewing several commercially available 
solutions to the problem of keeping files in sync between multiple hard drives, it became apparent that 
what was available was either not user friendly or did not satisfy our needs, hence the development of 
PeerSync.    Typically one of our developers would work on-site at a customers location or at home during 
crunch schedules and then would have to synchronize data back to the office server after returning to the 
office.    Typically this was done manually, i.e. individual files were dragged to the appropriate server 
folder.    This usually ended in frustration because invariably one, or several, files on the server would be 
newer and subsequently overwritten causing loss of data.    This process was also time consuming.    
Anywhere from 20 minutes to 2 hours was spent during each synchronization.    

Description
PeerSync offers an intuitive interface that shows the user exactly what is required to synchronize multiple 
directories and sub-directories easily and efficiently.    PeerSync allows folder matching between any 
connected drive on a local computer or network of computers.    

File dates and times are checked and only synchronized if target files are in fact older.    Extensive filtering
capabilities have been incorporated.    Files can be filtered using standard DOS type wild card filters.    
Files can be excluded using sub-string comparisons, or file attribute settings.    Additionally files can be 
excluded by dates or file size.    The user has the choice of updating and or adding target files.

Batch mode and command line mode operation are also available.    Virtually unlimited numbers of folder 
combinations can be selected and stored in batch files that can be run manually or automatically from the 
command line arguments.    Each folder combination can have a unique set of inclusions and exclusions 
allowing for very precise folder matching in an automated environment.

PeerSync is also used for network file management purposes.    The latest version allows network 
administrators to generate a complete report of what files have changed or been added prior to actually 
synchronizing them.    Reports can be created during actual synchronization runs showing added, updated
and opened files, created directories and unmatched files in target directories.    

PeerSync is Fast! Comparison of 10,000+ files can take less than 2 minutes (speed will vary with 
equipment used).



PeerSync Menus

File Menu Description    

Load Default Settings:    This item loads the last saved initialization file.    If no file exists, default 
settings are assumed.

Save Default Settings:    This item saves the current application settings to the initialization file.

Verify Compressed File:    This item displays a file open dialog box allowing you to select a 
compressed folder file to inspect and repair if necessary.

Exit:    Closes PeerSync and saves the current data to the initialization file if the “Save Settings On 
Exit” option is checked in the Options Menu (see below).

View Menu Description    

Folder Selection:    Selects the Folder Selection Tab item in the Main Window.    

Synchronize: Selects the Synchronize Tab item in the Main Window.    

Build Batch Lists:    Selects the Build Batch Lists Tab item in the Main Window.          

Expanded Options:    Expands/Reduces the Expanded options screen.    When the options are 
displayed, the application height will approximately double with the display of the expanded options 
screen.

File Options: Selects the File Options Tab item in the Options Window.

Compression: Selects the Compression Tab item in the Options Window.

Reporting Options: Selects the Reporting Tab item in the Options Window.

Run Batch Lists: Selects the Run Batch Lists Tab item in the Options Window. 

Display Reporting Form: Toggles the Expanded ReportingForm on and off.

Options Menu Description 



Display Errors During Operation:    This option suppresses all message displays during any 
operation.    Where applicable, messages are responded to automatically, i.e.: If a file is not 
accessible, “Ignore” is selected automatically as if the user had responded manually.    When a choice
would be required manually, the choice that will allow the process to continue is chosen (if 
applicable).

Show Hints: Within the PeerSync application there are many items that contain simple help 
information that help with understanding the functionality of the item.    This option toggles the display 
of these hints on/off.    Hints are displayed when the cursor is idle and over the item in question.    Not 
all items in PeerSync have hints associated.

Enable Pop Up Menus:    This option toggles the display of the Pop up menus that are available for 
the folder and file listing items in PeerSync.    When enabled, the off (usually right) mouse button can 
activate a pop up menu for the item that the cursor is currently over.    

File listing menu is as follows:    

View/Launch File:      This option will open the selected file using the standard Windows Notepad editor 
program.    If an application with the “.EXE” or “.BAT” extension is detected, this option will launch (run) 
the selected application.    For compressed files (red list), the selected file will automatically be expanded 
to a temporary folder and then executed.    The temporary folder files will be deleted when PeerSync is 
terminated.    PeerSync also checks this temp folder every time is started.    If no file is selected in the list, 
this option will not be available.

Delete File:    Displays a dialog box asking if you want to delete the selected file(s).    This feature 
works on compressed (red list) files also.    If no file is selected in the list, this option will not be 
available.

Show File Detail:    Displays a dialog box with the File Name, Size, Date, Time and Attributes.    This 
feature works on compressed (red list) files also and additionally will display the compressed size of 
the file.    If no file is selected in the list, this option will not be available.

Compress File List:    Automatically compresses all files in the file list into the compressed folder file. 
If a compressed folder file does not exists, it is created.    See Compression screen

Consolidate File List: Automatically compresses all files in the file list into the compressed folder file 
and then deletes the uncompressed version of the file.    This can greatly reduces required disk space 
for the selected files.    If a compressed folder file does not exists, it is created.    See Compression 
screen

Expand Compressed Folder: Automatically expands all files in the compressed folder file into the 
current folder.    Compressed file is NOT deleted.    This option is only available if a compressed folder 



file is detected in the current folder.    See Compression screen

Folder listing menu is as follows:      

Refresh File Listing:    Updates the folder/file list in the current folder.    This is usually done automatically
from within PeerSync as the need arises.

Create Folder:    Displays a dialog box that will allow you to change to an alternate folder or create a 
new folder that does not currently exist.

Delete Folder:    Displays a dialog box asking if you want to delete the selected folder.    Always verify 
that the folder you want to perform this action on is first selected (highlighted) in the list.    If the folder 
is not empty, you will be prompted prior to deleting all files within the folder.    This function is 
recursive, i.e.: all sub-folders within the selected folder will be automatically deleted when you select 
yes to the prompt for file deletion.

Sort File Lists:    This option toggles on/off the file listing sort option.    When checked the files listed 
in the source and target file listings will be sorted alphabetically.    When sorting is not selected, the 
files are listed in the order which they were added to the folder (native arrangement).    This option is 
only available from the Folder Selection screen.

Save Settings On Exit:    When this option is checked, all file options and menu settings are saved to
the initialization file when the application is closed.    Disabling this option allows you to make changes
for the current process without changing your default settings.

Swap Source and Target:    This option automatically swaps the folder in the source listing with the 
target listing.    

Help Menu Description    

PeerSync Help:    Load the on-line help file.    Help can also be initiated by selecting “F1” from your 
keyboard.    The current PeerSync screen will be the active help screen displayed.

About PeerSync:    Displays the About PeerSync dialog box.



Registering and Password

Registering PeerSync
You can register PeerSync by sending a check or money order for $37 (US) to:

TDM, Inc.
1363 Veterans Highway, Suite 44
Hauppauge, NY 11788

or

VIA CompuServe using the Software Registration facility: 
--    GO SWREG, Key Word Search: PeerSync

or

With your MC or VISA credit card by calling (516) 979-1770 
between the hours of 9:00 AM and 4:00 PM EST
Information required: 
    - Full name (as it appears on the credit card)
    - Address (city, state or province, country and postal 
code)
    - Phone number
    - Entire card number
    - Card expiration date
    - EMail address or FAX number 

(required for sending authorization key to unlock 
evaluation counter in software)

    - Version of software required: Win3.x or Win95/NT

Registered PeerSync Version 1 and 2 users can upgrade to version 3.x for $18 (US).

Registered PeerSync Version 3.0 users can upgrade to this version of PeerSync by downloading the 
latest update and installing the upgrade in the existing PeerSync folder.    The existing authorization 
keys should allow full access to the new release (no additional fees required).

Discount Schedule - applies to quantity requested in same order:

Quantity Discount
5 copies for the price of 4 20%

25 copies for the price of 19 24%
50 copies for the price of 35 30%
75 copies for the price of 45 40%

100+ at half price 50%



Discount example: If you purchase four (4) copies in one order, you will be authorized to use five (5) 
copies.

Upon registering PeerSync, a password will be generated from your name or your company name.    
This password will be faxed or e-mailed to you and will activate your current copy of PeerSync.    Please
note, TDM will not mail any disks unless specifically requested by purchaser and additional shipping 
and handling fees are paid to TDM.    All software will be activated via generated password sent over fax
or e-mail

If you need to install this application on a different PC than where it was initially run, Fax or e-mail a 
request to TDM for a new password.    TDM will provide one additional password
for a second PC if that PC will be operated by the same individual.    Otherwise, additional license fees 
must be paid for multi-user use.
===========================================================
Please fax or e-mail any comments you may have that can help us to improve this product.
===========================================================
PeerSync may not be commercially distributed, distributed by government agencies or any of its 
contractors, UNLESS registration fees are paid for by the distributing party.

This file may not be included in CD-ROM distributions, bundled with other files, or offered for retail sale 
without notifing TDM, Inc. and obtaining authorization.
===========================================================
You may share evaluation copies of the software with others provided it is not for revenue and all 
original files are part of the distribution and authorization codes are not part of the distribution.
===========================================================

Note regarding updates: as new updates/changes become available, updated versions of the 
software will be posted on CompuServe, WinShare forum.    Check this forum periodically and down 
load the latest executable s.    Your authorization key will continue to work with the updated versions 
until either a major release is issued or you install PeerSync in a different folder than you installed the 
authorized version of PeerSync.

TERMS AND CONDITIONS

READ THIS BEFORE USING THIS PROGRAM. BY USING THIS PROGRAM, YOU ARE AGREEING 
TO THESE TERMS AND CONDITIONS. 

TOP-DOWN MAINTENANCE (TDM), INC. SPECIFICALLY DISCLAIMS ALL WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THIS PROGRAM. 

TDM, INC. SHALL HAVE NO LIABILITY WITH RESPECT TO ANY LOSS OR DAMAGE DIRECTLY OR 
INDIRECTLY ARISING OUT OF THE USE OF THIS PROGRAM.    WITHOUT LIMITING THE 
FOREGOING, TOP-DOWN MAINTENANCE, INC. SHALL NOT BE LIABLE FOR ANY LOSS OF 
PROFIT, INTERRUPTION OF BUSINESS, DAMAGE TO EQUIPMENT OR DATA, INTERRUPTION OF 
OPERATIONS OR ANY OTHER DAMAGE, INCLUDING BUT NOT LIMITED TO DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES.



Please Fax or CompuServe any suggestions, comments or requests for support to the 
proprietor of PEERSYNC.EXE:

TDM, Inc. 
1363 Veterans Highway, Suite 44, 
Hauppauge, NY 11788

Fax Number: (516) 979-1870
CompuServe Address 74521,1261

Copyright 1993-1996, TDM, Inc.

All Rights Reserved. Reproduction in whole or in part without permission is strictly prohibited.

Entering Your Password
After registering PeerSync, you will receive a User Name and a Password.    To enter this information in 
PeerSync, start PeerSync.    Select “About PeerSync” from the Help menu, enter your User Name and 
Password in the appropriate text fields in the lower left side of the About PEERSYNC.EXE dialog box.    
Be sure to enter the information exactly as you have received it.

After entering an acceptable User Name and Password the About PeerSync dialog box will change and 
be displayed as follows:



Additionally the About PeerSync dialog box will appear at the start of PeerSync for approximately 3 
seconds.    The evaluation copy is set on an 8 second timer.



Replication
See Also File Options

Replication can be accomplished Automatically or Manually with PeerSync:

1. Automatic file replication of Target folder with Source folder can be selected from the File Options 
form.

When the Replicate toggle is selected, a dialog box will appear with a warning regarding deletion of 
unmatched files in target folder.    You will also be able to input a delay, in seconds, prior to file 
deletion.    (A value of 0 will bypass delay.)

When Replicate is selected, all file option selections are ignored.    Replication implies that you want 
all files to match on source and target.

2. Manual file replication of Target folder with Source folder can be accomplished by selecting the List 
UnMatched Files option in the Reporting form and setting all file options in the File Options form to 
include all files.

After running Synchronize Source to Target, you can delete any unmatched files from the Reporting 
forms UnMatched listing.



Reporting
The Reporting screen provides a means for selecting the type of information you require in your log files.   
Additionally you can run a report prior to actually synchronizing the selected folders.    

Log File Settings
Create Pre-Sync Report:  Select this option to run a report prior to actually synchronizing the 
selected folders.    All options and criteria for synchronization are utilized, except the actual copy 
function is bypassed.    During this operation, any folders that do not exists will be temporarily created 
and then delete at the end of the operation.    Please note that the report will reflect all files that 
require synchronization (based on selected criteria) even if those files are in use at the time.    No 
message is displayed for files that are not accessible during this operation.

File Name: Enter the file name for the pre-sync report.    The default name is PreSync.Log.

Overwrite: This option determines if the file will be appended or overwritten.

View:  Opens the file in the file name field using the standard windows NOTEPAD (or WRITE or 
WORDPAD) editor program.

Use Log File:    This option determines if a log file will be created/appended.    There is only a slight 
performance loss using this option.

File Name: Enter the file name for the log file.    The default name is PeerSync.Log.

Overwrite: This option determines if the file will be appended or overwritten.

View:  Opens the file in the file name field using the standard windows NOTEPAD (or WRITE or 
WORDPAD) editor program.

Include Updated Files:    Add a line for any file that is updated.

Include Added Files:    Add a line for any file that is added.

Include Empty Folders:    Add a line for every folder that is checked even if no files require 
synchronization from the folder.

Include File Size:    Include file size on same line as file name.

Include File Date: Include file date on same line as file name.

Include File Time: Include file time on same line as file name.

Include Folder Creation: Include line identifying any folders that did not exist on the target and had 
to be created.

Include File I/O Errors:    Include any file input/output errors generated by the application.

Include Application Errors:    Include any application errors.    

Note: Application errors are additionally written to a file called “PSError.LOG” even if this option 



is not selected.

Reporting
Use Report Form:    This option will send added, updated, excluded, unmatched (if selected), errors, 
and any deleted files to separate lists in the Reporting Form.    Additional program overhead/time is 
required to use this feature.

List UnMatched Files:  If selected, all target files are added to the list and subsequently removed as 
source files are found that match them.    Remaining files after synchronization is completed are 
unmatched in the Source folder.    Additional program overhead/time is required to use this feature.

Display Reports:  Toggles the Expanded Reporting Form on and off.

Note: When one of the lists appears in red, this indicates that the files displayed are contained in 
compressed files or were expanded from a compressed file.

Expanded Reporting Screen
The Expanded Reporting Screen provides a mechanism for viewing, saving, retrieving, printing and 
modifying lists of file information that was generated during a synchronization process. 



Run Batch Lists
See Also Build Batch Lists

Run Batch List screen is the means by which you can perform the synchronization of the folder lists 
created with the Build Batch Lists screen.

Run Batch Features
File Name:  Use this pull-down list to select a previously loaded batch list.    Selecting a blank item 
from the list will automatically select the “Open” button.      This list of files will be retained in the 
application initialization file and the files will then be available for future use.    The last file that is 
selected becomes the first file in the list.    The list will retain a maximum of 10 files.    To delete a file 
from the list, select the desired file and hit the “delete” key.    See PeerSync Menus for more 
information regarding saving and retrieving initialization settings.

If the selected batch file is currently loaded in the Build Batch List screen, it is automatically removed 
cleared from the Build Batch List so editing will not occur during usage.    Be sure the batch file was 
saved in the Build Batch List screen prior to selecting it this way.    Loss of any changes may occur.

Open:    This button displays the file open dialog box allowing the user to select a batch “SNC” file to 
load.    On the Synchronize screen, the synchronization button is set to “Synchronize Batch List” and 
the “Run Batch List” option is toggled on.

Clear:  The clear button removes any loaded file from the batch listing.    On the Synchronize screen, 
the synchronization button is reset to “Synchronize Target to Source” and the “Run Batch List” option 
is toggled off and grayed out.

Edit:    The edit button sends the loaded batch file to the Build Batch List screen automatically and 
clears it from this screen.    This prevents using a batch list that may be edited (changed), forcing you 
to reload the list to actually run it.

Description:     This is the description that was entered for the file when it was created.

Selecting an Individual Batch Item:    By clicking on an individual item in the list, you can selectively 
run just that folder combination.    To accomplish this, turn off the “Run Batch List” option on the 
Synchronize screen prior to selecting the “Synchronize Source to Target” button.    All file options 
associated with this item will be used for the synchronization process.



Synchronize 
See Also File Options, Run Batch Lists, Reporting

Use the Synchronize screen to perform the selected folder synchronization.

Synchronize Features
Use Compression:  Sets the Use Compression option.    This option is duplicated in the 
Compression screen.    When checked, the label changes to Compress or Expand and turns red.    If 
checked, the off (or right) mouse button will toggle between Expand and Compress.    Note that the 
Source and Target path labels will be red, respectively, if use compression is selected

Folder Count: Counts all folders associated with the current source folder selection.    If used, the 
Folder Count will decrement as folders are synchronized and the thermometer indicator will show 
folder count progress.    (This thermometer measures folder count.)

Folder File (Count): Displays the total number of files requiring synchronization from the current 
source folder and the number of files that have already been synchronized from this folder.    The 
thermometer indicator will show file synchronization progress for the current folder.    (This 
thermometer increments by the size of the current file.    100% represents the cumulative file size of 
files listed in the source file listing.)

Include Sub-Folders:  Sets an internal flag to synchronize the current folder and all sub-folders.    
This option is duplicated in the File Options screen.

Added:    Sets an internal flag to add files that do not currently exist in the current target folder.      This
option is duplicated in the File Options screen.    As files are added, the count is incremented.    Note: 
If you click the off (or right) mouse button on this number (if it is greater than 0 and the Use Report 
Form option is checked) the Report Form screen will be displayed.

Note: This label “Added” will change to “Add” when the Pre-Sync reporting function is selected.

Updated:    Sets an internal flag to update outdated files that exist in the current target folder.    This 
option is duplicated in the File Options screen.    As files are updated, the count is incremented.    
Note: If you click the off (or right) mouse button on this number (if it is greater than 0 and the Use 
Report Form option is checked) the Report Form screen will be displayed.

Note: This label “Updated” will change to “Update” when the Pre-Sync reporting function is 
selected.



File Dates:    Displays the active include date settings that are set in the File Options screen.

Elapsed Time:  Shows the amount of time past since the “Synchronize Source to Target” button was 
selected.

Synchronize Source to Target:    This button activates the synchronization process for the current 
source and target folders.

Note: The description of this button will change to “Synchronize Batch List” if batch processing 
is available or may change to “Replicate…” if replication is selected or "Compress..." if 
compression is selected.

Replicate Folder: This option is duplicated in the File Optionsscreen.

Run Batch List: This toggle is available if a batch list has been loaded.    By default this toggle is on if
a batch list is loaded, however, you can turn off batch mode by deselecting this option.    This allows 
you to use the batch list as a source for selecting individual folder combinations without having to 
manually change to each of the source and target folders.    See Run Batch Lists for more information.

Misc
Note: If after a synchronization process has been completed and errors have been reported, 

the status message will display "Done: Errors were found", the off (or right) mouse button 
clicked on the status message (if the Use Report Form option is checked) will display the 
Report Form error screen.



What's New In Version 3.x

This release of PeerSync includes:

· Updated version for MS Windows 3.1 (16 bit version)

· New version for MS Windows 95 and MS Windows NT with long file name support (32 bit version)

· Both the 16 and 32 bit versions are functionally identical

· Added ability to drag and drop selected file(s) from the source folder to the target folder

· Folder/file replication function 

- Delete Unmatched target files Option

- Compression Option

· Improved reporting

· Ability to create a preliminary report prior to synchronization

· Log reports can now be overwritten or appended with no size limitation

· File lists that display included and excluded files

· Progress indicators for file copy progress, folder file completion, and total folder count completion

· Improved command line operation

· Improved unattended operation.    Full message suppression is now available during 
synchronization

· Entire application is compiled in one executable, unlike the Visual Basic release of PeerSync 
which required supporting DLL’s to operate.

· Better memory management

· Expanded file inclusion and exclusion capability

· Better user interface, all options are available through direct screens instead of dialog boxes

· Files can be opened or launched from the file list display

· File listings can now be sorted

· File attribute of target file is set to match source file

· Improved international format support

Please feel free to fax or e-mail your suggestions for future releases.








